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What is a Password Vault program and how can it be useful?

Internet shopping, banking and sometimes even only browsing requires the use of different passwords and 
pin numbers. As if it’s not bad enough to remember them all, they also have to be frequently changed as 
well!

With the Password Vault program, all that is to be remembered is only one password, and even that 
could be stored in encoded form in the same directory on PC’s hard drive, memory card or USB disk. This 
program will then automatically retrieve it, decode it and use it to unlock all other passwords, card and pin 
numbers, stored in the program.

These passwords, or any information stored by this program, can be decoded by the program and 
displayed in the program’s text box. The password can be then copied from this text box into memory, by 
highlighting the required text and pressing the Ctrl (holding) + C button, followed by clicking into the text 
box, asking for the password. For example, when login to Internet Banking, pressing Ctrl (holding) + V 
button, will paste the password there. This is called Windows Cut & Paste and is described in details in 
Windows help.

Using this method will prevent any malicious programs or viruses, monitoring keystrokes on your PC and 
thus stealing your private data!  This is an important security enhancement.

The Password Vault program for Windows PC is compact, portable and easy to use. There is no need for 
Windows installation, activation or Internet connection, and the program never expires.

Program does not collect, store or send any information to anywhere, and it only does what is designed for: 
Securely stores and retrieves your passwords, pin numbers etc.

The program can be stored in any directory on the PC’s hard drive, removable memory card or USB stick. 
Storing it on a removable card or USB stick enables you to carry your passwords everywhere you go. And 
they are safe there, since they are all encoded.

The only one encoding password locks all other passwords etc., and is not kept anywhere, unless you wish 
to do so via one of the program’s options. The same copy of the Password Vault program can be used by 
many users with different login names and passwords.

The program uses advanced coding algorithm “Blowfish “, designed by one of the world’s leading 
cryptographers - Bruce Schneier, Chief Security Technology Officer, BT 
“I know of no successful cryptanalysis against Blowfish.”
(Bruce Schneier in his book “Applied Cryptography”.)

PLEASE NOTE:

Password Vault program stores all deposited passwords and pin numbers in four files named:
“<user login name> _PASSVAULT.CSB”, “<user login name> _MAILVAULT.CSB”. ,
“<user login name> _MISCVAULT.CSB”. , “<user login name> _INETVAULT.CSB”.
These files are encoded with the user’s login password, which is not kept anywhere, unless you create 
a User Access File, using the program’s tool Create User Access File. This User Access File stores your 
password in encoded form in the same directory, where is the program file PASSWORD_VAULT.EXE.
If you decide for any reasons to open these files in some other program, for example MS Word,
PLEASE DO NOT SAVE THESE FILES FROM THAT PROGRAM!

Some programs during saving modify the file structure, and the content of the encoded
file will be lost. Since there is no need to open this file, avoid opening it, please.
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Downloading and installing Password Vault program

Password Vault program does not need Windows installation and it could run from a hard drive, 
USB drive or memory card, and it comes in a few packages: 

Does your Internet provider allow you to download “.EXE” files?

YES
1. Download or copy PASSWORD_VAULT.EXE - this is the program’s executable file.

2. Open Windows  Explorer, create a directory on your PC’s drive and download this file there. Then 
navigate to this file and double click on its icon. After the program starts, you can use the menu item 
Create Shortcut on Desktop, and next time you could start the program by clicking on its desktop 
icon.

3. Depending on your Windows setup, during the first run the program may tell you that you also 
may need one, or all of the following files:
      msvcr100.dll , mfc100.dll and mfc100u.dll (Windows XP),
They are available for download from our web pages.

4. You could also download to this directory this help file password_vault_help.pdf, which will be 
then accessible from the program.

	

NO, downloading of EXE files is not permitted

1. Create a temporary directory on your hard drive and download there
password_vault_files.zip, or password_vault_files.rar, if you prefer the WinRAR program.
This package contains an executable file, this help file and other files, you might possibly need to run the 
Password Vault program, as listed previously above.

2. Open Windows Explorer, navigate to this file and double click on its icon. In the Extraction Wizard click 
File->Extract All and you will be asked for a directory, where to extract the files. Not all directories might 
be accessible to you, so select one which is. Usually the simplest would be to select Local Disk (C) in 
displayed dialog and pressing the Make New Folder, create the Password Vault directory.
Then navigate to this newly created directory and double click on PASSWORD_VAULT.EXE file icon. The 
program will start and you can then use the menu item Create Shortcut on Desktop. Next time you can start 
the program by clicking on its desktop icon.

3. You could also download or copy into the temporary directory
password_vault_installation.zip or password_vault_installation.rar.

Open Windows Explorer, navigate to this file and double click on its icon. This will open the Extraction 
Wizard and then click File->Extract All. You will be asked for some temporary directory, where to extract the 
files. You could use the same temporary directory.
When all files are extracted, navigate in Windows Explorer to password_vault_instal.exe file and double 
click on its icon. When the installation program starts, you can check the box Create Shortcut on Desktop 
and next time you would be able to start the program by clicking on its desktop icon. (You could create this 
shortcut later, when the program is running.)
Press the Continue button and the program will ask you for the drive (and directory if you wish ), where to 
install the Password Vault program. Usually, the simplest would be to select Local Disk (C). This time, the 
installation program will create a Password Vault directory and Desktop icon for you.

PLEASE NOTE:
Since Password Vault could be also run from the USB drive, it does not need Windows installation and it is 

therefore not installed on your PC in the Windows Registry. Because of that,
you will not find the Password Vault program amongst the list of installed programs.

To uninstall this program, just delete the Password Vault directory with all the files in it.
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Setting folder options

	 If you cannot see in Windows Explorer any file extension, you can select in its menu the item
Tool menu -> Folder Options -> View. 

	 In the displayed dialog then mark off the item Hide extensions for known file types.

Additional Windows files needed sometimes by the Password Vault program:
   msvcr100.dll 

mfc100.dll
                         mfc100u.dll (XP Windows)

They are Windows support files, which might be already present on your PC, and downloading them is 
therefore not necessary.

Only when the program will not start without these files, (i.e. you might have some issues with access 
rights), then you should download them into the Password Vault program directory.

When downloaded into the Password Vault program directory, they will NOT overwrite the same files, used 
by other programs, already existing in installed Windows. They will be solely used by the Password Vault 

program.

These files are a part of password_vault_files.zip,  password_vault_files.rar,  
password_vault_installation.zip, password_vault_installation.rar

and during installation they will be automatically copied into Password Vault directory.

PLEASE NOTE:
Only one instance of Password Vault could run on a PC at a time.

This inbuilt feature is included to prevent any possible corruption of data files, should more than one user
login with the same name & password.

Different users could still run this program, but on one particular PC only one user at a time and one 
instance only.

For possible errors see Errors & Remedies  
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PLEASE NOTE:
To move displayed dialogs, click with the left mouse button within the dialog frame, hold it down and 

drag the dialog into desired position.

To minimize the main dialog,  click on “Minimize button”.  

Current program contains 4 different categories, each can contain a number of entries, limited only 
by the capacity of your PC storage. The categories are denoted as “PASS”, “MAIL”, “MISC” and 
“INET”. This should enable users to sort their data into smaller, manageable parts. It is up to the 
user to decide what will be stored under which category. Each category is treated separately and 

their backups are also separate files.

Adding, deleting or editing will affect only entries in the selected category. When creating a new 
user, all categories will start empty.

Only the latest versions have  these categories

Updating from previous versions

Before updating it is recommended to use the existing version of the Password Vault program and make 
a backup of your current personal data file. You could also make a copy of the whole directory, where 
Password Vault files are stored. This way you will assure that your stored data will be still usable, even if 
some power outage, or other catastrophic event happens during updating.

1. Updating from versions without data groups PASS, MAIL, MISC, INET:

Download the latest version of:
		  PASSWORD_VAULT.EXE and PASSWORD_VAULT_HELP.pdf
Open Windows Explorer and in the program’s directory replace the old version of these files with the 
newly downloaded. ALL your data in the current personal data file will be automatically copied into the 
file containing data under checkbox PASS. All other different files, each representing a different category 
introduced in the new version will be empty. As a backup, the original data file will be copied to the file with 
the same name, with “_PREV_VERSION_ “ added after the user’s name.
Your backup files will also be automatically converted.

2. Updating from versions containing already data groups PASS, MAIL, MISC, INET:

Download the latest version of:
PASSWORD_VAULT.EXE and PASSWORD_VAULT_HELP.pdf
Open Windows Explorer and in the program’s directory replace the old version of these files with the newly 
downloaded. Your data files and backups will be used without any changes.
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Using Password Vault for the first time

By unchecking 
Display Password characters, 
the password will be revealed.

When you login for the first 
time, select any name you 

like. For any subsequent 
login you would have to use 

the same name and same 
password. 

 
There could be as many 

users as you wish. For 
example,  you can store 

your passwords, card and 
pin numbers under name  

Jo Blo, your wife under the 
name  Jan, your daughter 

under name Lassie, etc. 
 

To keep your stored data 
private, everybody should 
use a different password, 

and at least 6 to 56 
characters or digits long. 

The Character “`” is not 
allowed and the program 
will automatically inform 

you. 
If user Jo Blo does not exist, program will ask if is it OK to create 

new user with login name Jo Blo and password 123456

If you click Yes,
new user Jo Blo will be 

created.

You can login under 
different names, and if 

such a user doesn’t exist, 
the program will create a 

new user.

There could be as many 
users as you wish, but 

they all could have 
different names and 

passwords

PLEASE NOTE:
Login password should be at least 6 and up to 56 long and

could contain any combination of characters or digits.
The only exception is the character “`” and the program will prevent you from entering it.
The longer is the login password, the better is the security of your stored information!.
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Menu

Create user’s Access File

Every time you wish to open the Password Vault program, an appropriate username and login password 
has to be entered.
You could create a user’s Access File, which is encoded and will contain your login password.
It will be stored in the same directory where Password Vault executable file
PASSWORDVAULT.EXE is stored. This file can be then used to start the program without login.

PLEASE NOTE:
If more than one user is using the same Password Vault program, then every user could create their own 
Password Vault data files, containing all stored information, like passwords, PIN numbers, etc.
Yet, only one user’s Access file can be created in the program’s directory.
When this file is present in the program’s directory, the program will always start with the user and 
password set in the Access file. To enable other users to login, this file has to be removed via the ‘Delete 
User Access File’ menu item by the user who created it.
If you create a user’s Access File, the security of your locked passwords, card and PIN numbers is only as 
good as the security of the drive, USB or memory card, containing the Password Vault program and the 
user’s Access File. Anybody having access on your PC to the Password Vault program’s directory, or USB 
drive, memory card with User Access File on it, can unlock all locked information, passwords, card and pin 
numbers, without knowing your login password!
If you don’t create a user’s Access File, then your login password is NOT STORED ANYWHERE and only 
you know it. If you forget your login password, your stored passwords, card and pin numbers etc., will be 
lost!

 To keep your data secured, the program does not have any ‘backdoors’,
i.e., it does not have any universal passwords!

To create a user’s Access File, click with the left Mouse button on menu item Create User Access 
File and the file will be created.

Next time you start the program, it will automatically log you in and it will start without a need to type 
any login user name or password.
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Selecting this menu item will create the following shortcut on the desktop. 
Double clicking with the left Mouse button, or single click with right 
Mouse button + selecting Open, will start the program.

Delete user’s Access File 
To delete user’s Access File click with left Mouse button on menu item Delete User Access File 

Create Shortcut on Desktop

Password Vault program will usually start by clicking in Windows Explorer with the left Mouse button 
on the executable file PASSWORDVAULT.EXE. This file could be stored on PC hard drive, on USB 
drive or memory card.

You can simplify the starting procedure by adding a shortcut to Windows Desktop.

To open this file in some other program, for example MS Word, 
YOU MUST NOT SAVE THIS FILE FROM THAT PROGRAM!  Some programs during saving modify 
the file structure and the content of the encoded password file will be LOST! 

PLEASE NOTE: 
When the icon changes to  this, it indicates that the Windows can’t find 
                                                                                       PASSWORD_WAULT.EXE file. 

You can then either:
Correct the settings on the shortcut (see Errors & Remedies )

      Using menu item 'Create Shortcut on Desktop' create a new shortcut, and    
      the new shortcut will replace the old one.

•
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Deleting user

Only the current user will be deleted, and if the user’s Access file exists, it will be deleted together with all 
user’s backup files. After successful deletion, the program will close.

Managing backups

Selecting ‘Backup Data File’ will create a backup of currently stored passwords, specific to the current 
user. If there are more users using this program, each with its individual access password, then the 
program will create a specific backup for each user. Users can access only their own backup files.
In the example above, the user is ‘GDlouhy’ and the backup was created on 28th June, 2012 at 10:37.
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Change password

When it becomes obsolete, the Login password could be changed. Selecting the menu item Change 
Password will display the above dialog. Since you are already login, the program does not ask for the old 
password. Entering a new password and subsequently retyping it will change the login password.   
 
Although at the beginning of the process your files are copied into temporary files, it is a good practice 
to make copies of all your data files[1] and store them somewhere safe, before changing the login 
password.  During this procedure your PC could malfunction and your data could be lost! 
 
When finished, the program will change your login password and all your files, i.e. all group’s data files and 
your backups files. They will be encoded with your new password and they will not be accessible with the 
old password any more...

After the process finishes, all temporary files created by the program  
will be not just deleted, but thoroughly shredded!

[1] All files found in the Password Vault program directory, starting with the user’s login name. This includes 
all user’s backups.

PLEASE NOTE:
If you have created a User Access File, this file will be shredded and you would have to create it again.

For the next login you will need to use a new login password.
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About Password Vault

Displays this document. It requires Adobe Reader to be installed on your computer. This is a free 
program, free to download from Adobe web site.

Current user

BRIEFLY:  
Password Vault program can be used by more than one user. To create a new user, simply login under a 
different name and program will proceed to create a new user with that name and entered password. 
 
Every user will have their own set of stored passwords, card and pin numbers etc., which will be protected 
by each user’s login password. This set will be made automatically available after the user’s successful 
login. 
 
When a User Access File is created by one user in the Password Vault program directory, the program will 
always start with that user’s settings. No other users would be able to login and open their data files. 
 
That implies that whenever some user creates a User Access File,  the Password Vault program’s directory, 
USB or memory card should be kept private, not exposed to some other potential users. Whoever has 
access to PC hard drive, USB drive or memory card, where the User Access File is stored, could read all 
stored passwords, card and pin numbers etc., belonging to the user who created the User Access File! 
 
User Access File can be deleted in the program by the user who created it, by simply selecting menu item 
Delete User Access File. This file could be also deleted by anybody by simply using Windows Explorer 
(to open it, press and hold down Windows key          and then press E key.) 
Then highlight the file name and press keyboard button delete, or right-clicking with Mouse and select 
menu item  Delete.
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Using Password Vault program

Clicking on Add NEW Password will activate ADD button and text fields, where you can enter description 
and then item’s private data (i.e. user name, credit card’s number etc.). After selecting the icon and entering 
description and password field, clicking the ADD button will encode and add the entered information to the 
appropriate category of the Password Vault file.

Stored pass-
words, card 
and pin 
numbers, etc., 
have to have 
different de-
scriptions.

Minimize          Close
  Button            Button

Menu

Click to add new password, 
card or pin number

PLEASE NOTE:
During retrieval, adding or editing individual entries, the corresponding data file in the program’s directory is 
never decoded. Program extracts only selected items and decodes them in computer memory.
Therefore, even if the computer shuts down with Password Vault opened, your data files are still encoded!

Click to select category.
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PLEASE NOTE: 
You can use any characters or digits with an exception of the character “`”, located usually on the left-top 
part of the keyboard. Program will stop you from doing so if you try. Maximum length for stored passwords 

is 127 and description is 20 characters or digits.

Revealing stored passwords

To retrieve the stored passwords, select the category and then click with the left Mouse button on the 
displayed item. The item’s description will be displayed together with the highlighted stored password. You 
can now press Ctrl (hold down) and c, and the password will be copied to the clipboard. In some open 
program navigate to the password text field requiring password, and press Ctrl (hold down) and V letter on 
the keyboard.
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Popup 
Right-click with Mouse on the item you wish to open its popup menu. By selecting Edit, the selected 
item name and password etc., will be decoded and placed into respective text boxes.

Select the icon, change item description and/or 
password, and then press Save button.

Delete Item  will delete the selected item.
Delete ALL will delete ALL displayed items, BEWARE!
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Possible Errors and Remedies

1. The program will not start after clicking on the desktop icon.
Message:

Explanation 1: USB drive or memory card, with Password Vault program is not inserted in PC port            or 	
		  PasswordVault.exe file on hard drive was deleted, renamed or damaged.
Remedy:         Insert USB drive or card, containing Password Vault program, or install new
		  PasswordVault.exe file

Explanation 2: If a USB drive or memory card, containing a Password Vault program is inserted in
		  different PC port, or there are more USB drives inserted in all different ports. USB drive with
		  Password Vault has been assigned a different drive letter.
Remedy: 	 Create new shortcut on Desktop. Open the Password Vault program from Windows Explorer
        		  and when the program opens, select menu item Create Shortcut on Desktop.

		  or

		  Open Window Explorer and find out which drive letter was assigned to the USB
		  drive, containing the Password Vault program. Then click with the right Mouse button on the 	
		  Password Vault program’s icon and from the menu displayed select Properties.

Program icon on the desktop might have changed from this                    to this

Change the drive letter in Start in the field
by typing over and then press the OK button.

If the new drive letter is for example F, then it 
should be changed from 
G:\Password_Vault\
to
F:\Password_Vault\

PLEASE NOTE:
If you are not sure which drive was assigned to the Password Vault program’s USB drive, note all available 
drives and then remove the USB drive with Password Vault program. Then compare and establish which 

drive PC was assigned to the Password Vault USB drive.
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2. Password Vault will not start.

Message: 	

Explanation:	 Only one instance of Password Vault could run on one particular PC at a time. 
		  This inbuilt feature is included to prevent any possible corruption of data files, 
		  should 	more than one user login with the same name & password.
		

3. Password Vault will not start.

Message:     USB Drive where Password Vault
	          program is copied is READ-ONLY

Explanation: Password Vault program could be started 	
                     from a PC hard drive,
                     USB drive or memory
                     card, and needs to write to its directory.

Remedy:      Change Password Vault program’s
                    directory to READ/WRITE.

To find out, open Windows Explorer, select the drive and 
directory the Password Vault program is on, and click 
with the right Mouse button to reveal the submenu. Select 
Properties and uncheck Read only check box 
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4. New data CAN’T be stored.

Message:      User doesn’t have correct file, or the file might be damaged.
                      Password Vault file can not be ound or opened.
                      Password Vault file can’t be read

Explanation: Some files on the Password Vault program’s USB drive were deleted or damaged.

Remedy:       Try to restore the file from backup. If not successful, the only way to correct this
                      problem is to delete the current user and then create a new one. Unfortunately, all the stored
                      data will be lost.

	           Use menu item Delete User. If this produces another similar error, open Windows Explorer, 
                      navigate to the Password Vault USB drive, find a file starting with your username, click on it 
                      with the right Mouse button and from the submenu displayed select Delete.

	           If this will not fix the problem, check your access rights for the directory you are running your 
                      Password Vault program. Every version of Windows has a different way to do that, so if in 
                     doubt, consult Windows’ help.

5. Clicking on Display Help menu will not display program’s help.

Message:       There were problems with the Acrobat Reader program, needed to display the help file.

Explanation:   Since you are reading this help file, it is unlikely that you will receive this message.
	            But if ever it will appear in the future, it is because the Acrobat Reader is not installed on your
                       PC, or the password_vault_help.pdf file is not copied to the program’s directory.  

Remedy:        Acrobat Reader can be downloaded free from many web sites, so search for one convenient
                      for you. After downloading it, run the program’s setup.

6. During saving of newly entered data, the program will not save.

Message:      Can’t make backup of Vault file!
                      The Vault file can’t be restored from the backup file!

Explanation:  During saving new data, the program first makes a copy of the original data file and only when
                      newly entered data is correctly saved into file, the copy is deleted. If data is not saved 
	           correctly, then the program will restore the original file from the copy made.

Remedy:       Check your access rights on the PC you’re working on. You have to be able to read & write to
                     the Password Vault program’s directory on a PC hard drive, USB or memory card. Check also
                     available free disk space and if necessary, delete some old files 



18

How to check free disk space 

Open Windows Explorer, navigate to the Password Vault program directory icon, click on it with the right 
Mouse button and from the menu select Properties.

How to check access rights

Click the Windows Start button in the left down corner of the screen and from the displayed menu select 
Control Panel. Then display all users registered on that installation of Windows. If you are registered there, 
select yourself and check your access rights.

If you are not registered, then you belong to some group, under which you can operate. Check the group’s 
access rights.

If you are not a member of any created group, then you are in the group of general users and their rights 
have to be Read/Write for the program’s USB drive.

You will not be able to change any rights, unless you or the group you belong to, are registered as Windows 
administrator. If you are not, then ask somebody with such registration to do it for you.

This task is thoroughly described in Windows Help and Support, available from the Start menu.
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BASIC TUTORIALS

1. Understanding the data storage

When you, for example, create a document or an image, you create a block of data in the memory of the 
computer, which has to be stored on some permanent storage device, like a hard drive, USB drive, CD 
ROM, memory card etc.

Think of every document, image, spreadsheet etc., as a file, similar to files in the filing cabinet. Files are 
sorted into folders, as depicted on the following picture.

Folders are stored into draws of the filing cabinet.

In the computer world, files, folders, filing drawers and cabinet are represented similarly as:
 
	 Files
	 Folders (also called directories)
	 Drives (filing drawers)
	 Cabinet (PC or data server)
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Files have names with an extension, which denotes the type of the file. For example, MS Word documents 
have extension “.doc”, text file created by Notepad program “.txt”, executable files “.exe”, some images 
“.jpg”, etc.

Directories also have names, but without the extension. For example “My Documents”, “Program Files” etc.

Drives have only a letter, with optional name. For Example “My Data (D:)”.

You can change these names by opening Windows Explorer, right-click on the name you wish to change 
and from the popup menu select “Rename”. Then type the new name in the highlighted box.

Directories can have one or more subdirectories. You can create new directories, or subdirectories in 
Windows Explorer by selecting the top directory (it will be highlighted), and then from the menu select

File -> New -> Folder

New folder will be created with the name “New Folder” highlighted. You can type in the box your new name 
for the folder. Be aware that not all characters are allowed to be used in naming files, directories or drives. 
Recommended characters are letters a-z, A-Z, numbers 0 - 9, underscore ‘_’ and hyphen ‘-’. Do not start 
any directory or file name with a number.

You can delete the folder by selecting it in Windows Explorer, right-clicking and from the pop-up menu 
selecting “Delete”.

You can also copy files or folders. Select it in Windows Explorer, right-click and from the pop-up menu 
select ‘Copy’. Then select where you would like to copy it and from the pop-up menu select “Paste”. Please 
note that you will not see this menu item, unless you have previously copied the file or directory name into 
the computer’s memory.

If you wish to move the selected directory or file, follow the procedure above, but instead of selecting 
“Copy”, select “Cut’. Then paste it to the desired location. Selected directory or file will be moved from its 
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USB drives are just an extra amount of memory which can be used for storage of data. They are remov-
able, and therefore you can keep some personal information, use them to transfer data between different 
computers, send away some data, like documents, photographs etc.

After inserting an empty USB drive into the USB slot on your computer, the operating system will add this 
drive to the list of available drives, and you can then use it as any other hard drive.
(Scenario 3 in the picture above ).

If the USB drive contains some data, the initial response from your computer will depend on the  actual 
format of the data and also on the setup of your operating system.  Usually the computer will ask you what 
to do with the inserted drive it found.

You can insert a USB drive into the computer any time after the Windows operating system is loaded and 
running. 

PLEASE NOTE:
If you insert a USB drive before starting your computer, you might encounter problems, depending on the 
setup of your computer,. In such a case, the Windows usually try to load the operating system from the 

inesrted USB drive. 

2. Inserting USB drive
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On some earlier versions of Windows, it is advisable not to remove the USB drive before disconnecting it 
from the operating system.

In the picture above is described the correct procedure. If you have more drives on your computer, before 
disconnecting one particular, you would have to know what drive letter was assigned to it after insertion into 
the USB slot on the computer.

You can use the program Windows  Explorer, supplied with the operating system. To start this program, you 
can either:

	G o to->Start label (marked                   )->All Programs->Accessories->Windows Explorer
	 OR 
	 On keyboard press and hold Windows button (marked        )  and then press letter E.

3. Safely removing USB drive



23

The Internet is formed by connected computers. When your PC is connected to the Internet, then you are 
part of it too!

To connect your PC to the Internet, you need an Internet Provider (IP). This could be a phone company or 
some independent IP. 

There are different types of connections:	

	 1. Via existing phone line using a modem
               This could be dial-up, Broadband or one of DSL modems 						    
		      (Digital Subscriber Line)
	 2. WiFi Connection
	 3. Satellite Wireless Connection
	 4.  Dedicated Leased Line

Your IP will usually provides you with the following:

	 1. Modem 
	 1. User name
	 2. Password
	 3. Instruction on how to set-up modem and Internet access.		
	 (... and the bill, of course)

4. What is Internet
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Your Internet Provider can connect you not only to the Internet, but can also keep for you your Email box 
and/or host your web site. You can also choose to have Email and/or your web site hosted by some other 
company, not necessarily by your IP provider.

After applying for E-mail box, the hosting company will provide you with:

1. Username and password to access your Email - it could be different from user name        and password 
used to connect to the Internet
2. Names of the hosting servers:
  - server for the incoming mail - usually POP3 server
  - server for the outgoing mail, usually SMTP server

(If your Email box is hosted by another company than your IP provider, it is quite common to use a POP3 
server from your IP provider and SMTP from the company hosting your Email).

With this information you can then set the Email accounts on your Email program, like for example MS 
Outlook, Outlook Express and many more, offered by different companies.

To host your web site, you need additional information:

1. The name of your hosting server - Host Name (for example archie.thinline.cz)
2. User ID/name and password - it could be different from user name and password used
   for connecting to the Internet and E-mail
3. Some FTP programs, which enable you to transfer, delete and rename files on your web
     site. With widely used WS_FTP program, you can copy files from your PC to the server
     hosting your web site, provided that your PC is connected to the Internet.

Once connected to the Internet, programs like Web browser, Skype, Google Earth will usually after the 
installation connect automatically.

You could also set up your e-mail by selecting from many free Webmail offerings, like Gmail, Hotmail, etc.
For the latest offers just browse the Internet for “Free Email”.
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This document, including all text and images, is copyrighted, all rights reserved. 
For commercial use the written consent from author George Dlouhy is required.

                                                                  DISCLAIMER:

Information in this document is not professional, scientific, medical, technical or expert advice and may not 
be accurate, current or complete. It is subject to change without notice and should never be relied on as the 
basis for doing or failing to do something. Links in the document are not endorsements.

Every care has been taken to verify the accuracy of the information contained in this document, but 
no warranty is given. You accept all risks and responsibility for losses, damages, costs and other 
consequences resulting directly or indirectly from using the Password Vault program and any information 
or material available from it. To the maximum permitted by law, we exclude all liability to any person arising 
directly or indirectly from using this program and any information or material available from it.

LICENSE TERMS
1. This is FREE software, but the copyrights in this software and any visual or audio work  
    distributed with the software belong to George Dlouhy.  All rights are reserved. 
2. By using this software, you, on your own behalf and on behalf of your employer or principal, 
    agree to be bound by these terms. If you do not agree to any of these terms, 
    you may not use or distribute this software.
3. This software, and all accompanying files, data and materials are distributed “as is” and with 
    no warranties of any kind, whether express or implied, except as required by law. If you     
    intend to rely on this software for critical purposes, you must test it fully prior to using it, install  
    redundant systems 
    and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not limited 
    to, any special, incidental or consequential loss. There is no remedy against us for whatever 
    claims.
5. You may not use this software in any circumstances where there is any risk that failure of this 
    software might result in a physical injury or loss of life. You agree to indemnify us 
    from any claims relating to such unauthorized use.
6. There is no data collected by the software and usage of the software is covered by 
    Privacy Statement, enclosed on author’s web sites. 
7. The contract arising out of this agreement is governed by the laws 
    and courts of the Australian Capital Territory.
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Password Vault program is written by George Dlouhy, © George Dlouhy, 2001
Last version V 5.21, SEPTEMBER 2022

It is a free program and as long as it is original and not modified,
it could be distributed for free. 

The program does not access the Internet, does not need activation, does not collect
any information and it is distributed in its full version, which never expires.

. This document and Password Vault program are free to distribute for non-commercial purposes. 

Cogito, ergo sum.
(I think, therefore I am.)
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